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1. Manual Information 
 

This Windows Driver Installat ion Manual provides informat ion on installat ion, detailed 
specif icat ions, and usage of the printer’s Windows Driver according to PC operat ing system (OS). 
 
We at POSBANK maintain ongoing efforts to enhance and upgrade the functions and 
quality of all our products. In following, product specifications and/or user manual content 
may be changed without prior notice. 

 

 
 

2. Operating System (OS) Environment 
 
The following operat ing systems are supported by this Windows driver. 
 

Microsoft®  Windows XP SP3 (32bit)  
Microsoft®  Windows XP SP1 or later (64bit)  
Microsoft Windows Server 2003 SP1 or later (32bit/64bit) 
Microsoft Windows VISTA (32bit/64bit) 
Microsoft Windows Server 2008 (32bit/64bit) 
Microsoft Windows Server 2008R2 (64bit) 
Microsoft Windows 7 (32bit/64bit) 
Microsoft Windows 8 (32bit/64bit) 
Microsoft Windows Server 2012 (64bit) 
Microsoft Windows 10 (32bit/64bit) 
 

* Serial and Bluetooth printer ports do not work on Windows 10 version 1511 (OS Build 
105860.104) specific. We recommend you to install the latest Windows 10 update through 
Windows Update before installing Windows Driver. 

 
You can download and install the Windows Update in the Update & security tab of the 

Settings menu (  > Settings > Update & security > Windows Update). 
 
 
 

3. Windows Driver Preparation 
 
The Windows Driver is included in the enclosed CD, and latest f ile versions can be downloaded 
from the POSBANK website. (www.posbank.com) 

http://www.posbank.com/
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4. Windows Driver Installation 
 

4-1 Installing on Windows XP / Server 2003 
 

4-1-1 Via Serial Port or Bluetooth 
 
1) Double-click the Windows Driver installat ion f ile. 
 
2) Click Next. 
 

 
 
3) Select a COM port to be used, and then click Next. 

 

 



A11 Prime 

 

4) Click Yes to reboot the PC. 
 

 
 
5) Open the printer propert ies window in the Windows OS. 

※ Control Panel – Printers and Faxes. 
 
6) In the Ports tab, click Configure Port. 

※ Skip this step in case of data communicat ion using Bluetooth. 
 
7) Match the communicat ion sett ings to those of the printer. The communicat ion sett ings of the 

printer can be performed by conduct ing a self-test. 

※ Skip this step in case of data communicat ion using Bluetooth. 
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8) Click Print Test Page and check print ing status. Proper installat ion of the driver is indicated if 
the test page is printed normally. 
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4-1-2 Via USB Port 
 
1) Double-click the Windows Driver installat ion f ile. 
 
2) Click Next. 

 

 
 
3) Select USB and then click Next. 
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4) Click OK. 
 

 
 
5) Turn off the printer and then turn it on. The printer driver will be installed automat ically. 
 
6) Open the printer propert ies window in the Windows OS. 

※ Control Panel – Printers and Faxes. 
 

7) Click Print Test Page and check print ing status. Proper installat ion of the driver is indicated if 
the test page is printed normally. 
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4-1-3 Ethernet / Wireless LAN Port 
 
1) Double-click the Windows Driver installat ion f ile. 
 

2) Click Next. 
 

 
 
3) Select Ethernet / Wireless LAN.  
 
4) Enter the IP address and port number, and then click Next. 
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5) Click Yes to reboot the PC. 
 

 
 
6) Open the printer propert ies window in the Windows OS.  

※ Control Panel – Printers and Faxes. 
 
7) In the Ports tab, click Configure Port…. 
 
8) Match the communicat ion sett ings to those of the printer. 

※ The “LPR” protocol is not supported with this printer. 
 

 
 



A11 Prime 

 

9) Click Print Test Page and check print ing status. Proper installat ion of the driver is indicated if 
the test page is printed normally. 
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4-2 Installing on Windows VISTA / Server 2008 / 7 / 8 / Server 2012 / 10 
 

4-2-1 Via Serial Port or Bluetooth 
 

1) Double-click the Windows Driver installat ion f ile. 
 
2) Click Next. 
 

 
 
3) Select a COM port to be used, and then click Next. 
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4) Click Yes to reboot the PC. 
 

 
 
5) Open the printer propert ies window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 
 
6) In the Ports tab, click Configure Port. 

※ Skip this step in case of data communicat ion using Bluetooth. 
 
7) Match the communicat ion sett ings to those of the printer. The communicat ion sett ings of the 

printer can be performed by conduct ing a self-test. 

※ Skip this step in case of data communicat ion using Bluetooth. 
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8) Click Print Test Page and check print ing status. Proper installat ion of the driver is indicated if 
the test page is printed normally. 
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4-2-2 Via USB Port 
 

1) Double-click the Windows Driver installat ion f ile. 
 
2) Click Next. 
 

 
 
3) Select USB and then click Next. 
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4) Click OK. 
 

 
 
5) Turn off the printer and then turn it on. The printer driver will be installed automat ically. 
 
6) Open the printer propert ies window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 
 
7) Click Print Test Page and check print ing status. Proper installat ion of the driver is indicated if 

the test page is printed normally. 
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4-2-3 Ethernet / Wireless LAN Port 
 

1) Double-click the Windows Driver installat ion f ile. 
 
2) Click Next. 
 

 
 
3) Select Ethernet / Wireless LAN.  
 
4) Enter the IP address and port number, and then click Next. 
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5) Click Yes to reboot the PC. 
 

 
 
6) Open the printer propert ies window in the Windows OS. 

※ Control Panel – Hardware and Sound – Device and Printers. 
 

7) In the Ports tab, click Configure Port…. 
 
8) Match the communicat ion sett ings to those of the printer. 

※ The “LPR” protocol is not supported with this printer. 
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9) Click Print Test Page and check print ing status. Proper installat ion of the driver is indicated if 
the test page is printed normally. 
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5. Windows Driver Settings 
 
The following funct ions can be configured after installing the Windows driver. 
 

5-1 Layout 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 
2) In the General tab, click Preferences (Print ing Preferences).  
 
3) Click the Layout tab. 
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5-1-1 Paper Size 
 

Paper size of 80 x 3276 mm is selected by default, and the following sizes can be selected.  
 

80  40 mm 80  160 mm 80  3276 mm 

80  80 mm 80  200 mm  

80  120 mm 80  297 mm  

 
If a custom paper size is required, click “…” to add or update a custom paper size. Click Save after 
specifying the paper width/length and a paper name. If the specif ied paper name already exists 
on the system, you can update the paper width/length. 
 

Valid Paper Width  (Printable Width) : 25.4 mm ~ 72.0 mm 
Valid Paper Length (Printable Length) : 25.4 mm ~ 3276.0 mm 

 

 
 
You can choose the new paper size on the Paper Size combo-box after adding a paper size. 
 

 
 
Delete button : Deletes the paper size selected in the list. 
Save button : Adds a new paper size or update the paper size selected in the list if the paper 

name already exists on the system. 
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5-1-2 Paper Type 
 
You can choose Receipt or Ticket as paper types. Receipt allows flexible paper length according 
to the data length. Ticket print in f ixed length even the print data is short. Default sett ing is 
Receipt. 
 
Receipt : Receipt allows flexible paper length according to the data length. 
Ticket : Ticket print in f ixed length even the print data is short. 
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5-1-3 Copies 
 

Copies are printed by specifying the copy count. The copy count is set to 1 by default. Set this 
value bigger than 1 to set the number of copies to print. The value should be within the range of 1 
to 255. 
 
5-1-4 Image Rotation 
 

Image rotat ion is available for image data only. It means that rotat ion of device fonts or barcode 
fonts is not supported.  
 
5-1-5 Paper Reduction 
 
Reduct ion funct ion reduces the size of the print image to save print paper. If this funct ion is 
enabled and print-job data includes text data created by using a printer font, device fonts are 
converted to True Type fonts to make them smaller. The barcode size also can be reduced by 
select ing “Enable reducing barcode”. 
 
5-1-6 Crop Function 
 
This funct ion crops the upper and lower end of the print ing area by the specif ied number. It helps 
reduce the margin at the top and bottom when there is excessive margin. The value should be 
within the range of 0 to 255. 
 
5-1-7 Orientation 
 
Print ing orientat ion can be set to Portrait (which is the default) or Landscape. It is not possible to 
use device fonts and device barcodes in landscape. 
 
Portrait   : Print ing in the vert ical direct ion. 
Landscape : Print ing in the horizontal direct ion. 
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5-2 Document Settings 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 
2) In the General tab, click Preferences (Print ing Preferences).  
 
3) Click the Document Settings tab. 
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5-2-1 Send Command 
 
The Windows driver serves to receive the content for print from an applicat ion and send it to the 
printer. The “Send Commands” funct ion allows for the addit ion of desired commands at the start 
or end of the print content. 
 
Start Doc : Addit ion of command at the beginning of the document. 
Start Page : Addit ion of command at the beginning of the page. 
End Page : Addit ion of command at the end of the page. 
End Doc : Addit ion of command at the end of the document. 
 
For more informat ion about the hexadecimals that can be entered in “Start Doc”, “Start  
Page”, “End Page” and “End Doc”, refer to the Commands Manual. 
 
5-2-2 Cash Drawer / Internal Beep 
 

To open a cash-drawer before print ing, t ick “Open before print ing #1” or “Open before print ing 
#2”. 
 
To open a cash-drawer after print ing, t ick “Open after print ing #1” or “Open after print ing #2”. 
 
To make a beep sound when print ing, t ick “Beep sound before print ing” or “Beep sound after 
print ing”. 
 
5-2-3 Line Feed 
 

It is possible to set the number of line feeds between 0 and 99 for adding blank lines at the end of 
print ing. 
 
5-2-4 Paper Cut 
 

Paper can be cut at the end of each page or each document (job). 
 
Page/Job : No Cut / No Cut : Paper is not cut after print ing. 
Page/Job : No Cut / Partial Cut : Paper is cut at the end of each document (Job). 
Page/Job : Partial Cut / Partial Cut : Paper is cut at the end of each page. 
 
 
 



A11 Prime 

 

5-3 NV Image 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 
2) In the General tab, click Preferences (Print ing Preferences).  
 
3) Click the NV Image tab. 
 
The posit ion to print NV image stored in the printer can be set at the beginning and/or end of the 
document and beginning and end of each page. Also, there are two commands for NV Image 
print ing. Take care of select ing one of the two commands because NV images cannot be printed 
depending on the selected command. 
 

※ NV graphics: “FS p” 

※ NV bit image: “GS ( L” 
 

Start Doc : Insert NV image at the top of the document. 
Start Page : Insert NV image at the top of the page. 
End Page : Insert NV image at the end of the page. 
End Doc : Insert NV image at the end of the document. 
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5-4 Barcode 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 
2) In the General tab, click Preferences (Print ing Preferences).  
 
3) Click the Barcode tab. 
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5-4-1 1d Barcodes 
 
Windows driver supports one-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed by using following font names. 
 

Font Name Type (Symbology) Size (Point) Supported Characters 

Barcode1 UPC-A 20 / 40 / 60 / 80 Numeric: 0~9 

Barcode2 UPC-E 20 / 40 / 60 / 80 Numeric: 0~9 

Barcode3 JAN13 (EAN) 20 / 40 / 60 / 80 Numeric: 0~9 

Barcode4 JAN8 (EAN) 20 / 40 / 60 / 80 Numeric: 0~9 

 
Barcode5 Code39 20 / 40 / 60 / 80 

Numeric: 0~9 
Symbols: $, +, -, ., / 

Letters: A~Z 

Barcode6 ITF 20 / 40 / 60 / 80 Numeric: 0~9 

 
Barcode7 Codabar 20 / 40 / 60 / 80 

Numeric : 0~9 
Symbols: $, +, -, ., /, : 

Letters: A~D 

Barcode8 Code93 20 / 40 / 60 / 80 ASCII CODE: 0x00 ~ 0x7F 

Barcode9 Code128 20 / 40 / 60 / 80 ASCII CODE: 0x00 ~ 0x7F 

 
If you want to change the default value of 1d barcode properties, select a Font Name and Type of 
one-dimensional barcode, and then click Properties. Click OK after changing the values of 
properties. 
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5-4-2 2d Barcodes 
 
Windows driver supports two-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed on the printer by using following font names. 
 

Font Name Type (Symbology) Size (Point) 

2D-Code1 PDF417 9.5 

2D-Code2 QR Code 9.5 

 
If you want to change the default value of 2d barcode properties, select a Font Name and Type of 
two-dimensional barcode, and then click Properties. Click OK after changing the values of 
properties for PDF417 or QR Code. 
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5-5 Dithering 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 

2) In the General tab, click Preferences. 
 

3) Click the Dithering tab. 
 
This printer model is a black and white print ing device including dithering funct ion, This printer 
model is a black and white print ing device including dithering funct ion and brightness level 
adjustment funct ion to produce a sharper or softer image. The following dithering algorithms can 
be selected. 
 

- None  
- Error Diffusion  
- Ordered Dither  
- 4x4 Matrix  
- 8x8 Matrix  
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5-6 Utility 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 
2) In the General tab, click Preferences (Print ing Preferences).  
 
3) Click the Utility tab. 
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5-6-1 Unified POS Utility 
 
Refer to the Unified POS Utility manual contained in the CD for details. 

  
5-6-2 Special Font Edit Utility 
 
The purpose of FontControlA font is not for text print ing. It is used to define the printer 
command, assign the defined printer command to a specif ic ASCII character, and send it to the 
printer. The range of ASCII code that the command can be assigned is from 0x20 to 0x7F, and the 
command can be easily assigned using this ut ility. 
 
1) Click Special Font Edit. 
 
2) Select an ASCII code character and enter the print command. All values should be  

entered in hexadecimal number format. 
 
3) Click Apply and then click OK.  
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5-6-3 Journal Viewer 
 

Journal is a funct ion to save a copy of printed receipts. Copies can be saved without using journal 
printer with this funct ion. Journal saves each printed document in a f ile and the saved f ile can be 
viewed by using this ut ility. 
  
1) Tick Enable Journal to run Journal Viewer, and then click Journal Viewer. 
 

 
 
2) Click Search to set search condit ion, and then enter Start Date and End Date. 
 
3) Click OK to search the f iles created within the specif ied period. 

 

 
 

4) Select the f ile to print from the list and click Print to send the data stored in the f ile to the 
printer. 
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5-6-4 Text-Key Function 
 
Text-Key Funct ion is a ut ility to replace specif ic text (Text-Key) with other texts or graphic images, 
and to add images to the bottom of receipts. This funct ion can be used only when using device 
fonts. It has no effect when using TTF fonts (True Type Fonts) or the data for Text-Key does not 
exist on a Print-Job.  
 

▶ How to replace Text-Key with other texts. 
 
1) Tick Enable Text-Key Function and then click Text-Key Function. 
 

 
 
2) Click Add New Key, type a text to be used as Text-Key, and then click OK.   
 

 
 

 



A11 Prime 

 

3) If the Text-Key is selected, The Configuration button is enabled.  
 
4) Click Configuration to enter a text, which is used to replace the selected Text-Key with the text 

entered. For example, if you enter “APPLE” in the text box as below, the Text-key, “POTATO” 
can be replaced with “APPLE”. 

 

 
 

▶ How to replace Text-Key with a graphic image and to add it to the bottom of receipts. 
 
1) This ut ility can also replace the selected Text-Key with a graphic image instead of texts and can 

add a graphic image to the bottom of receipts. It is necessary to add images to the image list. 
 
2) Click Add New Image to browse for an image to add to the list. 
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3) Enter a unique name to be added, adjust the brightness, select a dithering type, and then click 
OK. Repeat 2 to 3 step to add up to as much as you want.  

 

 
 

 
 
4) Select a Text-Key in the Text-Key list, and then click Configuration.  
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5) To replace the selected Text-Key with a graphic image, select one of the available ident if ier via 
the combo box under “Replacement” label. There are two replacement funct ions but only 
one of the two is available.  

 

  
 
6) In order to print a graphic image to the bottom of receipts, select one of the available ident if ier 

via the combo box under “Adding a image to the bottom of receipts” label. The graphic 
image for the selected ident if ier only will be printed if the data for the selected Text-Key were 
found on a Print-Job. 
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5-6-5 Print Preview 
 
This applicat ion with a preview of a print-job runs, and windows driver does not directly send 
print-job data to the printer when enabled by clicking “Enable Print Preview”. Print-job data can 
only be sent to the printer in the applicat ion. The actual output of preview image processed by 
the applicat ion might look a little different. 
 
1) Tick Enable Print Preview to make Windows Driver ready for running the applicat ion. 
 

 

 
2) When print-job data are created via Windows Driver, the applicat ion runs, and then loads the 

data to draw the expected output on screen.   
 

3) Click Print if you want to print, or click Close to exit the applicat ion.  
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5-7 Bidirectional Communication 
 

 
 

1) Open the Printer Propert ies window for the corresponding OS. 
 
2) Click Ports tab.  
 
It is necessary to t ick Enable bidirectional support to get status from the printer. Sample codes 
contained in the CD can help you get more status informat ion than the status informat ion that 
OS supplies as standard way. 
 

Printer status that OS support Printer status that OS does not support 

 
- ONLINE/OFFLINE 
- COVER OPEN/CLOSE 
- PAPER EMPTY 

 
- NEAR END PAPER 
- CASH DRAWER OPEN/CLOSE 
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6. Windows Driver Specifications 
 

6-1 Font 
 
This Windows driver supports various fonts in the following table. Print ing using these fonts  
is faster than using Windows fonts provided by the operat ing system. 
 

Printer Font (Device Fonts) Name Font Size (dot) Font Size (point) 

FontA1x1 FontA1x1[Ext.] FontA1x1[255] FontA1x1(12x24) 9.5 

FontA1x2 FontA1x2[Ext.] FontA1x2[255] FontA1x2(12x48) 19 

FontA2x1 FontA2x1[Ext.] FontA2x1[255] FontA2x1(24x24) 9.5 

FontA2x2 FontA2x2[Ext.] FontA2x2[255] FontA2x2(24x48) 19 

FontA2x4 FontA2x4[Ext.] FontA2x4[255] FontA2x4(24x96) 38.5 

FontA4x2 FontA4x2[Ext.] FontA4x2[255] FontA4x2(48x48) 19 

FontA4x4 FontA4x4[Ext.] FontA4x4[255] FontA4x4(48x96) 38.5 

FontA4x8 FontA4x8[Ext.] FontA4x8[255] FontA4x8(48x192) 77 

FontA8x4 FontA8x4[Ext.] FontA8x4[255] FontA8x4(96x96) 38.5 

FontA8x8 FontA8x8[Ext.] FontA8x8[255] FontA8x8(96x192) 77 

FontB1x1 FontB1x1[Ext.] FontB1x1[255] FontB1x1(9x17) 7 

FontB1x2 FontB1x2[Ext.] FontB1x2[255] FontB1x2(9x34) 13.5 

FontB2x1 FontB2x1[Ext.] FontB2x1[255] FontB2x1(18x17) 7 

FontB2x2 FontB2x2[Ext.] FontB2x2[255] FontB2x2(18x34) 13.5 

FontB2x4 FontB2x4[Ext.] FontB2x4[255] FontB2x4(18x68) 27 

FontB4x2 FontB4x2[Ext.] FontB4x2[255] FontB4x2(36x34) 13.5 

FontB4x4 FontB4x4[Ext.] FontB4x4[255] FontB4x4(36x68) 27 

FontB4x8 FontB4x8[Ext.] FontB4x8[255] FontB4x8(36x136) 54.5 

FontB8x4 FontB8x4[Ext.] FontB8x4[255] FontB8x4(72x68) 27 

FontB8x8 FontB8x8[Ext.] FontB8x8[255] FontB8x8(72x136) 54.5 

FontC1x1 FontC1x1[Ext.] FontC1x1[255] FontC1x1(9x24) 9.5 

FontC1x2 FontC1x2[Ext.] FontC1x2[255] FontC1x2(9x48) 19 

FontC2x1 FontC2x1[Ext.] FontC2x1[255] FontC2x1(18x24) 9.5 

FontC2x2 FontC2x2[Ext.] FontC2x2[255] FontC2x2(18x48) 19 

FontC2x4 FontC2x4[Ext.] FontC2x4[255] FontC2x4(18x96) 38.5 

FontC4x2 FontC4x2[Ext.] FontC4x2[255] FontC4x2(36x48) 19 

FontC4x4 FontC4x4[Ext.] FontC4x4[255] FontC4x4(36x96) 38.5 

FontC4x8 FontC4x8[Ext.] FontC4x8[255] FontC4x8(36x192) 77 

FontC8x4 FontC8x4[Ext.] FontC8x4[255] FontC8x4(72x96) 38.5 

FontC8x8 FontC8x8[Ext.] FontC8x8[255] FontC8x8(72x192) 77 
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Printer Fonts are defined as follows. 
 

1) FontA1x2 
- ANSI Character code support (Code Page 1252) 
- Font size (dot): 12 x 48 (Double height) 
- Font size (point): 19 

 
2) FontA1x2 [Ext.] 

- IBM expansion Character code support (Code Page 437)  
- Font size (dot): 12 x 48 (Double height) 
- Font size (point): 19 

 
3) FontA1x2 [255] 

- Buyer exclusive code support   
- Font size (dot): 12 x 48 (Double height) 
- Font size (point): 19 
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6-2 Special functions 
 
This Windows driver supports the special funct ions as shown in the following table. 
Select FontControl font f irst and use the characters in the table to use the special funct ions. Take 
care as this funct ion is not for print ing general texts. 
 

Character Special Function 

5 Prints HT (0 x 09) 

6 Prints LF (0 x 0A) 

7 Prints CR (0 x 0D) 

a Open Drawer 2 (50ms drive pulse width) 

b Open Drawer 2 (100ms drive pulse width) 

c Open Drawer 2 (150ms drive pulse width) 

d Open Drawer 2 (200ms drive pulse width) 

e Open Drawer 2 (250ms drive pulse width) 

f Open Drawer 2 without paper feeding (50ms driver pulse width) 

g Cut Receipt (part ial cut) without paper feeding 

i Prints the NV Image saved in the 00 address (double-size) 

j Prints the NV Image saved in the 01 address (double-size) 

k Prints the NV Image saved in the 02 address (double-size) 

l Prints the NV Image saved in the 03 address (double-size) 

m Prints the NV Image saved in the 04 address (double-size) 

p Does not add HRI characters to the barcode 

q Adds HRI characters in Font A above the barcode 

r Adds HRI characters in Font A below the barcode 

s Adds HRI characters in Font B above the barcode 

t Adds HRI characters in Font B below the barcode 

u Turns white/black reverse print ing mode on 

v Turns white/black reverse print ing mode off 

w Aligns text to the left 

x Aligns text to the center 

y Aligns text to the right 

A Open Drawer 1 (50ms drive pulse width) 

B Open Drawer 1 (100ms drive pulse width) 

C Open Drawer 1 (150ms drive pulse width) 

D Open Drawer 1 (200ms drive pulse width) 

E Open Drawer 1 (250ms drive pulse width) 

F Open Drawer 1 without paper feeding (50ms driver pulse width) 

G Prints the NV bitmap saved in the 00 address 

H Prints the NV bitmap saved in the 01 address 

I Prints the NV bitmap saved in the 02 address 

J Prints the NV bitmap saved in the 03 address 

K Prints the NV bitmap saved in the 04 address 

P Cut Receipt (part ial cut) 

R Prints the NV Image saved in the 00 address 

S Prints the NV Image saved in the 01 address 

T Prints the NV Image saved in the 02 address 
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U Prints the NV Image saved in the 03 address 

V Prints the NV Image saved in the 04 address 

[ Prints the NV bitmap saved in the 00 address (double-size) 

] Prints the NV bitmap saved in the 01 address (double-size) 

^ Prints the NV bitmap saved in the 02 address (double-size) 

_ Prints the NV bitmap saved in the 03 address (double-size) 

` Prints the NV bitmap saved in the 04 address (double-size) 

 
1) Example 
 
Select FontControl font and send 6 for “LF” (Line Feed) operat ion. 
(instead of print ing character “6”).  
 
2) FontControl font funct ions. 
 

Font Name Special Functions Font Size (point/dot) 

FontControl 

Open Drawer 1/2 
Cut receipt 

Cut receipt(without paper feeding) 
Just if icat ion (Left/Center/Right) 
Output HT, Output LF, Output CR 

Barcode Print ing 
Print NV Graphic Data 

(9.5 / 12x24) 
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7. Use of Windows Driver 
 
7-1 Use of Visual Basic 
 
This sect ion contains example codes to control the printer using Windows driver with Visual Basic. 
Sample programs are included in the CD. 
 
7-1-1 Windows Driver Selection 
 
The following example code explains how to select “PB-11P Miniprinter” Windows driver. 
 

 
For Each prnPrinter In Printers 
 
If prnPrinter.DeviceName = “PB-11P Miniprinter” Then 
 
Set Printer = prnPrinter 
 
Exit For 
 
End If 
 
Next 

 

 

7-1-2 Text Printing 
 
The following example code explains how to print texts using Windows Fonts and Device Fonts. 
 

 
‘Print in Windows font 
Printer.FontSize = 9 
Printer.FontName = “Arial” 
Printer.Print “Arial Test”  
 
‘Print in printer font 
Printer.FontSize = 9.5 
Printer.FontName = “FontA1x1” 
Printer.Print “FontA1x1 Font”  
 
Printer.EndDoc 
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7-1-3 Barcode Printing 
 
The following example code explains how to print the barcode (JAN8 (EAN)). 
 

 
'Print Bar Code. 
Printer.FontSize = 20 
 
Printer.FontName = "Barcode4" 
Printer.Print "1234567" 
 
Printer.EndDoc 

 

 
The following example code explains how to print the 2D barcode (PDF417). 
 

 
'Print Two-dimensional Codes. 
Printer.FontSize = 9.5 
 
Printer.FontName = "2D-Code1" 
Printer.Print "Print Test PDF417" 
 
Printer.EndDoc 
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7-2 Use of WordPad 
 
7-2-1 WordPad Environment Settings 
 
Launch WordPad, set the print ing related opt ions as follows, and test the printer with WordPad. 
 

- Select printer 
Select “Print” from the “File” menu, and select the printer (PB-11P Miniprinter). 

 
- Set paper size, orientation, margin, etc. 

Select the “Page Sett ing” from “File” menu, and set paper size, orientat ion, and margin. 
 
7-2-2 Text Printing 
 
Print the text from WordPad using the Windows driver of the printer. 
 

 
 
1) Select the font from the font select ion box (FontA1x1). 
 
2) Select the point size from the point select ion box (9.5). 
 
3) Enter the text to print. 
 
4) Click the Print icon in the toolbar to print the text. 
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